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CHAPTER 1

User Interface

1.1 Main Window

After launching mRemoteNG for the first time you will be see the main interface window looking similar to what is
being shown below.

In the next part we will start to explore the interface of mRemoteNG.

1.1.1 Default Screen

The default screen of mRemoteNG

• Menubar - Main menu, Quick Connect

• Sidebar - Connections, Config

1
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Fig. 1: mRemoteNG 1.77 first launch

• Work area - Remote Connections

• Footer - Notifications

The default interface is very basic in that it will show the most important part to get started with mRemoteNG. We
will explain more details of the interface further on this document.

1.1.2 Customization

See also:

Keyboard Shortcuts - For keybindings in mRemoteNG

mRemoteNG supports themes and keyboard shortcuts.

Note: Keyboard shortcuts can be overwritten when a connection is active. Since the connection might use the same
shortcut

The mRemoteNG shortcuts will work when the interface is in focus but not so often when the remote connection is
active.

Themes

These can be chosen from the Tools → Options. There are also possibilities to create your own themes inside the
settings for themes. By default mRemoteNG has turned off the themes but they are easily enabled by choosing another
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Fig. 2: mRemoteNG default Screen, RDP to a Windows 2012 R2 host

theme rather then the default (vs2015light) one.

Warning: In order for the theme to load, mRemoteNG needs to be restarted

1.2 Panels

mRemoteNG is using tabs and panels to stay organized but also to create a better view of all multitasking that is being
done inside the application.

1.2.1 Explanation

Panels are used to organize tabbed conections. This might seem a bit confusing at first glance but is a great way to
stay organized. Below is a few examples of how to use panels to give you a hands on better view of them:

• Test and Production - You can add 2 panels where you have test servers in one panel and production connections
in the other

• Datacenters - Maybe you want to divide panels into different datacenters

• Temp project - To see all servers you work on for a temporary project

• Home vs Work - Or divide them up into where home connections are and work connections are located

1.2. Panels 3
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As you can see the panels organization do have benefits to it. Below you will see a screenshot of a organized view
where Domain A is in panel 1 and Domain B is in panel 2.

Fig. 3: Example two panels created with Domain A and Domain B

The function of a panel works as a sort of workspace.

1.2.2 Creating Panels

Usually panels are created using connections and folders to stay organized automatic when making connections.
However you can also create panels manually.

Fig. 4: Menu items for panels under View

Creating manual panels will make you able to organize tabs manually in mRemoteNG. To then open a connection to
the new panel, right click on the connection and use Connect (with options) → Choose panel before connecting

The other option in the menu name Connection Panels will list all panels that are available in mRemoteNG window.

1.2.3 More Options

If you right click on the panel there are a few more options that can be set:

Fig. 5: Right click context menu for panel

• Rename - Rename the panel

• Send to. . . - Send the whole panel to monitor/screen [number]. Note this is not a real window but a detachable
panel. If you double click the title then the panel will go back to mRemoteNG window and not fullscreen the
window.

1.3 Menu Container

1.3.1 Hide Menu Container

You can hide the Menu Container when right-clicking the mRemoteNG title bar.
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1.3.2 Main Menu

In this section we are going to explain the menus located in mRemoteNG.

• Red - Anchor to move menu around the interface

• Green - The menu items

File Menu

Contains standard commands for the application.

Item Description
New Connection Will add a new connection to the Connections dialog after where the cursor is

positioned.
New Folder Add a new folder in the Connections dialog tree where the cursor is positioned.
New Connection File Create a new connection file. Dialog will come up asking about: filename and

where to place the new connection file.
Open Connection File Open a connection file. Dialog comes up asking about which file to open. For

security reasons, this also shows a dialog to ask if you want to save the current
file before continuing.

Save Connection File Saves the currently opened connection file. If you are using a SQL server con-
nection instead it will send a save to the SQL server.

Save Connection File As. . . Saves the current connection file to a specific location on disk.
Delete. . . Delete currently selected item in connections dialog.
Rename Rename current selected item in connections dialog.
Duplicate Duplicate current selected item in connections dialog.
Reconnect All Open Connec-
tions

Sends a reconnect to all the open connections in mRemoteNG.

Exit Exit mRemoteNG application

View Menu

Menu for additional dialogs for mRemoteNG.

1.3. Menu Container 5
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Item Description
Add Connection Panel Create a new and empty panel.
Connection Panels Jump to panel.
Connections Show connections dialog
Config Show config dialog
Notifications Show notifications dialog
Screenshots Open Screenshots Manager (See: Screenshot Manager)
Jump To Place focus on “Connections”, “Config” or “Notifications” panel based on se-

lection.
Reset layout Resets the layout of panels and dialogs. Warning will come up about the action

before continuing.
Lock toolbar positions Locks the toolbars at the top of the application so you do not move around items

by mistake.
Quick Connect Toolbar Show quick connect toolbar
External Tools Toolbar Show external tools toolbar
Multi SSH Toolbar Show multi ssh toolbar
Fullscreen Fullscreen mRemoteNG (will not fullscreen connection window but only the

mRemoteNG application)

Tools Menu

Additional tools that can be used and triggered in mRemoteNG.

Item Description
SSH File Transfer Show SSH file transer panel (See: SSH File Transfer)
External Tools Show external tools dialog (See: External Tools)
Port Scan Show port scan dialog (See: Port Scan)
Options Opens mRemoteNG global settings and options dialog

Help Menu

Get more information for the application.

Item Description
mRemoteNG Help Show help panel (this panel)
Website Go to mRemoteNG website
Donate Go to mRemoteNG donation page
Support Forum Go to mRemoteNG suport forum
Report a Bug Go to github page to report a bug
Check for Updates Opens dialog to check for any updates of mRemoteNG
About Open about dialog for mRemoteNG (Shows contributors, changelog and more)

1.4 Connections

The connections dialog is the main collection of all connections that inside mRemoteNG. This document will explain
the details of the connections dialog.
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1.4.1 Connection Tree

Menu Items

• Red - New Connection

• Green - New Folder

• Blue - View (Expand/Collapse all folders)

• Yellow - Ascending sort

New Connection

Tip: You can also duplicate an existing connection. Just right click on folder or connection to duplicate the item. The
information is then carried over for editing. This can save a lot of time when the connection list is large.

Tip: When inside an SSH session you can open the PuTTY menu by holding down the CTRL key while right-clicking
into the session window.

Creates a new connection item in the connections dialog after where cursor is present.

New Folder

Tip: Folders can help to make adding connections easier. By setting a folder with some values that can be inheritaded
down to the connections.

Creates a new folder in connections dialog after where cursor is present.

View

Collapses or expands all directories in the connection dialog. Useful when working with a lot of connections sorted in
different directories.

Ascending

Works like a sort or a refresh to get connection in ascending order. (Descending order is note supported yet) When
you have been moving around in the tree of connections, just click this item to refresh the list and get everything in
ascending ordering.

1.4.2 Configuration

Config dialog to setup the connection specific properties. This includes inheritance from other items before the item
and more. Details below is about how to work with this dialog to get the most out of connections and configuration.

1.4. Connections 7
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Menu Items

• Red - Sort values Categories or Alphabetical

• Green - Show Properties, Inheritance values

• Blue - Connection icon

• Yellow - Host status (based on ICMP ping)

Sort Values

Sorts the values in properties either by Categories or Alphabetically.

• Categories sort - Shows values in categories with expanding options.

• Alphabetical sort - Expands everything and shows values in alphabetical order instead

Icon

Note: Don’t forget that mRemoteNG will save the change on exit auto unless you have unchecked this setting in
options.

The icon indicates the visual identifier for the connection. Clicking the icon will let you set a different icon for the
connection.

Status

Note: In order for this to work you have to open up ICMP. On windows servers this is also disabled in windows
firewall.

Is a indicator that will glow red or green depending on the status of the host. The status is based on ICMP ping to the
host.
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1.4.3 Creating a connection

Tip: You can see an indicator in the properties window that is glowing green:

This icon does a ICMP ping on to check response from the server. If it glows green it indicates a connection response
can be made using ping to the host. However this is turned off on windows by default. You have to enable ICMP and
allow the firewall access for it.

Right click on the root item (the little blue globe named Connections) in the Connections panel and select New
Connection.

A new item shows up under the root item. You can give it a name now (or rename it later). We’ll just call this
connection “Test” for the moment.

Now lets look at the config panel in the bottom left, just under the connections panel. As you may notice this is where
you configure all the properties of connections and folders.

Fill in the necessary properties and you have just created your first connection! You can now connect to the server
with a simple double-click on the “Test”-connection!

1.4. Connections 9
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1.4.4 Opening and Closing Connections

Note: If the connecting fails, the notifications panel will pop up and show an error message describing the problem.

There are multiple ways to open a connection in mRemoteNG, but the easiest way is to double click the connection
in the Connections panel. If you double click the connection you will notice that the connection is going to try and
open in a new panel called “General” and under a tab called “Test”. If all goes well you should see the remote desktop
without any problems.

To close the connection you can do any of the following:

• Log off in the start menu (Closes the connection and logs you out completely from RDP)

• Close the panel with the (Which leaves your session active on server but closes connection in mRemoteNG)

• Close the connection tab with (Also keeps your login active on server but closes RDP connection in mRe-
moteNG)

• Double click the connection tab (Same as above where the connection is active on server but closes RDP con-
nection in mRemoteNG)

1.5 Default Connection Properties

Default connection properties are a template that is applied when creating new connections. You can set both property
values and inheritance settings that will be set in new connections.

Note: Currently, default connection properties are saved within the user settings of mRemoteNG and not with the
connection file. Sharing a connection file between multiple machines will not share default connection properties.

1.5.1 How it is used
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New Folders/Connections

When a new folder or connection is created, all default properties and default inheritance are applied to it.

Note: Changing default properties does not affect existing connections. The default values are only applied when the
connection is first created.

Quick Connections

Default connection properties are also used when establishing quick connections. See Quick Connect for more details.

1.5.2 How to set them

You can set default properties and inheritance by going to the Connection Tree and clicking the appropriate button for
the default settings you would like to change.

• Red - Default connection properties

• Green - Default connection inheritance

1.6 Quick Connect

The Quick Connect functionality of mRemoteNG allows you to quickly connect to a remote host using a variety of
network protocols.

1.6.1 Prerequisites

• Knowledge of a DNS host name or IP address

• Knowledge of an appropriate protocol to communicate with remote host

• A predefined mRemoteNG connection

1.6.2 Using QuickConnect

Tip: You can input username and hostname simultaneously when using user@domain as connection string.

To use Quick Connect, ensure the Quick Connect toolbar is enabled by selecting View and then Quick Connect Toolbar.
Next, input a DNS host name or IP address into the box labeled “Connect”. This box will also save previous entries
during your session.

Select the appropriate network protocol by clicking the arrow next to the Connect box.

12 Chapter 1. User Interface
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If you wish to use an existing connection, select the globe icon next to the protocol button and select the appropriate
connection.

1.6.3 Configuration

Quick connections take most of their configuration from the Default Connection Properties. All default properties are
used except for:

• Hostname

• Protocol

• Port (the default port for the selected protocol is used)

1.7 Port Scan

The Port Scan feature (under Tools > Port Scan) is similar to a nmap port scan. It will scan a range of IP addresses
and to determine if specific mRemoteNG supported protocols are active. Hosts can then be bulk imported into mRe-
moteNG.

Tip: If you leave this at the default of 0 & 0, the test will be for the default protocol ports that mRemoteNG supports.

• Start the Port Scan feature by clicking Tools > Port Scan in the menu bar.

• Input your Start IP and End IP of the range you’d like to scan.

• Enter the Start Port and End Port that mRemoteNG should test for.

• Click Scan

1.7. Port Scan 13
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• Wait. Possibly a long time.

• The table will populate, and eventually you’ll get a notification that the scan has completed. Alternatively, you
can press Stop to end the scan at any time.

• Change the dropdown to the protocol you’d like to import and click Import.

1.8 Screenshot Manager

The screenshot manager is a panel and tool that can be used to organize and take screenshots inside mRemoteNG.

1.8.1 Take a screenshot

To take a screenshot of a instance its as easy as to right click on the connection tab and press Screenshot and it will
open the screenshot manager.

On the first image you can see the right click menu of the connection tab. Clicking the screenshot there will allow
mRemoteNG to create a screenshot.

The second image is where the screenshots are stored in mRemoteNG. Here you can store and then decide what to do
with the images after you are done taking screenshots.
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1.8.2 Editing

The manager is a simple tool for saving and deleting screenshots. If you need to do more with the screenshots then the
suggestion is to open them in a third party app. Here is what the manager allows you to do:

• Save

• Save All

• Delete

• Delete All

Once you press save, a window to save the files will come up where you want to save the screenshots.

1.9 Notifications

The notifications panel contains any errors or informational messages that mRemoteNG triggers. Some example errors
can be if there is a problem to connect, information on lost connection and so much more. Notification settings can be
found in (Tools > Options > Notifications) below we will explain what can be set and how they do affect for various
troubleshooting.

1.9.1 Notifications general settings

Tip: If you dont want the panel to show at all. Then unmark all options inSwitch to Notification panel on. Then the
panel will not come up automatically.

This will tell mRemoteNG what type of messages and the level of messages to send to the panel. It does not the level
for the log that mRemoteNG has but only for panel output.

There is also 2 different options mentioned below:

• Show these message types - Level of messages to show in panel. (default: Warnings and Errors)

• Switch to Notifications panel on - If interface should switch to the panel when a level of message occurs (default:
all enabled)

1.9.2 Logging settings

Here you define the logging of messages. That is a continues log which can be used to backtrack any error that has
occurred. Good when for example reporting issues about mRemoteNG or to check more details about problems.

Log path - Choose where the log should recide (default: Log to application directory) Log these message types - Level
of logging to logfile (default: Informations, Warnings, Errors)
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1.9.3 Popups settings

When items are selected here you will recieve a popup on the error that occurrs based on level chosen in settings here.
This can be useful if you do not want to use the notification area and only get a popup if error occurs. (default: all off)

1.10 Import/Export

You can import or export your connections to mRemoteNG. Imports can be done in various different ways. See below
for more information.

1.10.1 Import

Import from File

Opens a normal file load dialog to open a exported xml or csv file for mRemoteNG. See Export to file further down
this page for information on exporting your connections.

Import from Active Directory

This option can be used to import computers from a specific OU from you Arctive Directory.

1. Go to: File → Import → Import from Active Directory

2. Choose the domain to check for computers available

Note: Check the Import sub OUs checkbox if you want to import OUs recursively.

Import from Port Scan

This option opens a dialog to import connections from a port scan. Both network and port range can be specified.

Important: Port Scan uses nmap to scan the ports. Be carefull on how you scan your network, as this can be
considered a brute force attack.

• First IP - Start of ip to scan from

• Last IP - Stop of ip to scan to
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Fig. 6: Import from Active Directory dialog

Fig. 7: Import from Port Scan dialog
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• First Port (Optional) - Start port to scan from

• Last Port (Optional) - Stop port to scan to

• Timeout [seconds] - Seconds to wait until continuing scan

Once the scan is done you can select connections to import with some options on the lower part of the dialog:

• Protocol to import - Which protocol to use for the import of the connection(s)

1.10.2 Export to file

Here you can export your settings to a file to share or backup. The dialog shown below is the dialog of which you
chose the options to export.

Fig. 8: Export to file dialog example
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Export options:

Here is a detailed explanation of the export dialog.

• Filename - The output filename for which to save the export

• File Format - Currently supports xml and comma seperated csv output file format

• Export Items - Options to what you want to save

– Export everything - Will export all the connections

– Export the currently selected folder [nameoffolder] - Is used to only export all connections in the
folder selected. Note! the [nameoffolder] is the name to which you have selected in the connection
tree.

– Export the currently selected connection [nameofconnection] - Same as before with folder but uses
the currently selected connection for export.

• Export Properties - Properties of the specific connections to export

Note: Options do change based on what is selected in the connection tree. You can try this out by right clicking on a
folder and selecting Export to file on a connection to understand more

1.11 SSH File Transfer

SSH File Transfer functionality allows you to securely transfer files to a remote host over an encrypted tunnel using
either SFTP or SCP.

1.11.1 Prerequisites

• SSH File Transfer requires an SSH service to listen on an available network port (default 22) on a remote host.

• A username and password must be supplied to connect with the remote host.

• The remote host must have a writeable folder on its filesystem to place the transferred files.

1.11.2 Configuration Options

• Host - The remote host you connect to. Can be DNS name or IP address.

• Port - Remote network port listening for SSH/SFTP/SCP traffic.

• User - Username for account to log on to remote host.

• Password - Password for account to log on to remote host.

• Protocol - Choice of SCP or SFTP protocol used for communication.

• Local File - Path of file to transfer from local host.

• Remote File - Path where file will be transferred on remote host. (e.g. “/home/John/Documents”)
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1.11.3 Using SSH File Transfer

Begin by going to Tools → SSH File Transfer.

The tool will open a new panel inside mRemoteNG which allows you to configure some options for the SSH File
Transfer. Each option is needed in order to complete a file transfer over SSH.

Fig. 9: Main SSH File Transfer panel

• To populate the Local File option, select the Browse button and navigate to the desired file on the local filesys-
tem.

• To populate the Remote File option, manually type desired filesystem path, including the desired file name.

Once all options are populated, select Transfer and the progress bar at the bottom of the window will show the
progress of the transfer.

1.11.4 Troubleshooting SSH File Transfer

To troubleshoot issues with SSH File Transfer, consult the log under %AppData%\mRemoteNG\mRemoteNG.log.
This log provides verbose information about successful and failed connections.

Common Issues

ERROR - Please fill all fields This issue was likely encountered because you did not provide all information needed
to establish the connection.

ERROR- SSH background transfer failed! This issue was likely encountered due to a permissions issue. Ensure
you have appropriate access to write to the specified Remote File.
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System.Net.Sockets.SocketException (0x80004005): No connection could be made because the target machine actively refused it
This issue was likely encountered because the local host could not contact the remote host specified on the
remote port specified. The issue may be caused by improperly configured firewall rules or a SSH service not
listening properly on the remote host.

1.12 External Tools

External Tools can help you get things done that can’t be done in mRemoteNG.

For example you can:

• Start a command

• Launch your favorite FTP tool

This might not make much sense by itself because you can already launch your applications by using the Windows
Start Menu, Quick Launch or whatever you prefer to start your apps.

But from within mRemoteNG you can launch applications and tell them what to do with the use of arguments, pa-
rameters and variables of the currently selected Connection. You can, for example, select your home router’s SSH
connection entry and do a traceroute (tracert) on that host. This is much quicker and more powerful than opening the
console and typing tracert yourhost.

1.12.1 Main UI

The below image will show the main UI of External Tools. You may find the interface a bit confusing in the beginning
but we will explain the various items in more details below.

Menu Tools → External Tools

Fig. 10: External Tools open with one new entry
Toolbar (red), Tools/Items List (blue), External Tool Properties (green)
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Toolbar

Fig. 11: External Tools - Toolbar

New Shift-F4 Create a new external tool.

Delete Del Delete selected tool item in list.

Launch Run the current selected tool on currently selected connection.

Hint: All items can be accessed with right click menu and with a keyboard shortcut except for the Launch action.

Tools/Items List

Fig. 12: External Tools - Tools/Items list

Basically shows the list of Tools/Items that you have created with the arguments and options.

External Tool Properties

Fig. 13: External Tools - External Tool Properties

Is where you do most of the work to setup the Tool/Item for External Tools. We will explain each item further down
this page.

Display Name Name of the tool, this can be any type of name.

For example:

Open in FileZilla, FileZilla, Traceroute
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Filename Application/Command to run.

For example:

cmd, powershell, C:\WINDOWS\system32\compmgmt.msc, C:\Program
Files(x86)\FileZilla FTP Client\filezilla.exe

Arguments Sometimes also called switches and parameters. This is where you tell the application in the previous
(filename) input what to run. And also which variables from mRemoteNG to use for the arguments.

For Example:

sftp://%USERNAME%:%PASSWORD%@%HOSTNAME%:%PORT%, /K tracert
%HOSTNAME%, -NoExit tracert %HOSTNAME%

Working directory From where should this Tool/Item be ran.

1.12.2 Variables

Variables and arguments can be used to tell the external tool what to do.

This is the list of variables supported by mRemoteNG:

• %NAME%

• %HOSTNAME%

• %PORT%

• %USERNAME%

• %PASSWORD%

• %DOMAIN%

• %DESCRIPTION%

• %MACADDRESS%

• %USERFIELD%

mRemoteNG will also expand environment variables such as %PATH% and %USERPROFILE%. If you need to use
an environment variable with the same name as an mRemoteNG variable, use \% instead of %. The most common use
of this is for the USERNAME environment variable. %USERNAME% will be expanded to the username set in the
currently selected connection. \%USERNAME\% will be expanded to the value set in the USERNAME environment
variable.

If you need to send a variable name to a program without mRemoteNG expanding it, use ^% instead of %. mRe-
moteNG will remove the caret (^) and leave the rest unchanged. For example, ^%USERNAME^% will be sent to the
program as %USERNAME% and will not be expanded.

Rules for variables

• Variables always refer to the currently selected connection.

• Variable names are case-insensitive.

• Variables can be used in both the Filename and Arguments fields.
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1.12.3 Special Character Escaping

Expanded variables will be escaped using the rules below. There are two levels of escaping that are done.

1. Is escaping for standard argument splitting (C/C++ argv, CommandLineToArgvW, etc)

2. Is escaping shell metacharacters for ShellExecute.

Argument splitting escaping

• Each quotation mark will be escaped by a backslash

• One or more backslashes (\) followed by a quotation mark (“):

– Each backslash will be escaped by another backslash

– The quotation mark will be escaped by a backslash

* If the connection’s user field contains "This" is a \"test\"

* Then %USERFIELD% is replaced with \"This\" is a \\\"test\\\"

• A variable name followed by a quotation mark (for example, %USERFIELD%”) with a value ending in one or more backslashes:

– Each backslash will be escaped by another backslash

– Example:

* If the connection’s user field contains c:\Example\

* Then “%USERFIELD%” is replaced with "c:\Example\\"

To disable argument splitting escaping for a variable, precede its name with a minus (-) sign. For example: %-
USERFIELD%

Shell metacharacter escaping

• The shell metacharacters are ( ) % ! ^ ” < > & |

• Each shell metacharacter will be escaped by a caret (^)

To disable both argument splitting and shell metacharacter escaping for a variable, precede its name with an exclama-
tion point (!). For example, %!USERFIELD%. This is not recommended and may cause unexpected results.

Only variables that have been expanded will be escaped. It is up to you to escape the rest of the arguments.

1.13 Options

Options window which can also be named settings is the window where you can personalize your options for all of
mRemoteNG. This includes how to set logging, credentials and so on. Continue reading for the details of the different
options here.
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1.13.1 Startup/Exit

Options below are for the various settings for Startup/Exit of mRemoteNG.

Option Default Description
Reconnect to pre-
viously opened
sessions on
startup

Off This option will allow you to open the con-
nection from which you where connected to
after last exit of application

Allow only a
single instance of
the application
(mRemoteNG
restart required)

Off Enforces and makes sure only a single in-
stance of mRemoteNG is running on the com-
puter

1.13.2 Appearance

Various options for mRemoteNG appearance.

Option Default Description
Language (Automatically Detect) Which language to use for the interface of

mRemoteNG
Show description
tooltips in con-
nection tree

Off Holding mouse over a item in connection tree
will show a popout from mouse with infor-
mation

Show full con-
nections file path
in window title

Off Adds the complete path to the title of mRe-
moteNG to where the connection file is lo-
cated

Always show
notification area
icon

Off Adds mRemoteNG to the taskbar in the OS

Minimize to noti-
fication area

Off Will place mRemoteNG in taskbar on mini-
mize

1.13.3 Tabs & Panels

Various settings for how tabs & panels should work in mRemoteNG.
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Option Default Description
Always show
panel tabs

Off Will always show the tabs & panels in mRe-
moteNG

Open new tab to
the right of the
currently selected
tab

On When active then open next tab on the right of
the active selection in mRemoteNG. Turn this
off and next tab will open the next connection
at the end of all tabs

Show logon in-
formation on tab
names

Off Show your login in the connection tab

Show protocols
on tab names

Off When active then in the tab show what proto-
col is used for the connection

Identify quick
connect tabs by
adding the prefix
“Quick:”

Off When active shows Quick: before the con-
nection name in the tab connection to easier
identify what is a quick connection and what
is a non quick connection

Double click on
tab closes it

On When double clicking a tab it will close the
connection but does not log you out from the
server. The connection in this case is active
on the destination server

Always show
panel selection
dialog when
opening connec-
tions

Off Option to allow you to always select what
panel to place the connection on. If this is
off it will create a General panel where the
connection is placed or use the connections
set panel from the connection options

Create a empty
panel when mRe-
moteNG starts

Off On startup if this is active mRemoteNG will
create a panel mentioned under Panel Name
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1.13.4 Connections

Option Default Description
Single click
on connections
opens it

Off In connection tree when this is active will try
to connect on single click. By default this is
turned off to use double click to open connec-
tion.

Single click
on opened
connection in
Connection
Tree switches
to the opened
Connection Tab

Off Allows you to single click on a active connec-
tion in the connection tree to go to that open
connection in the tabs faster.

Set hostname
like display name
when creating
or renaming
connections

Off Will make mRemoteNG try to use the remote
host hostname to set the title of the tab in
mRemoteNG.

Filter search
matches in
connection tree

Off Allows you to filter out the connections to
which does not match your filter search in the
connection tree. If not active the search will
only select the filter to which you do search.

RDP Reconnect
count

5 Value in seconds

RDP Connection
Timeout

20 Value in seconds

Auto save time in
minutes (0 means
disabled)

0 Value in minutes

When closing
connections
Warn me. . .

. . . when any connection closes Various options of how mRemoteNG should
act when you close connections. The differ-
ent options are listed below:

- ... when any connection closes
- ... when closing multiple
→˓connections
- ... only when exiting mRemoteNG
- ... never
By default a warning will come
→˓up on closing a connection.
→˓Change this value based on
→˓your prefered settings.

Connection
Backup Fre-
quency

On Edit Various options of when mRemoteNG should
create a backup of the connections file. The
different options are listed below:

- Never backup connections
- On Edit
- On Exit
- Daily
- Weekly
By default a backup will be
→˓saved every time the
→˓connections are edited. Change
→˓this value based on your
→˓prefered settings.

Maximum num-
ber of backups

10 Number of backup copies of the connection
file to keep.

Location of
backup files

(blank) Full path of backup copies of the connection
files.
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1.13.5 Credentials

Options for credentials in mRemoteNG. The main purpose here is that when you have empty username, password or
domain field then use below information.

Option Default Description
None On Use no specific settings on login
My Current
credentials (Win-
dows logon
information)

Off This option will use the logon information for
the OS. This is useful if you are in a domain
that uses specific credentials and want to lo-
gin to servers with those credentials

The following Off Use one or two of the options below for the
empty login or all of them. For example if
you have a different domain that you login to
the servers with

1.13.6 SQL Server

Note: To understand more about SQL Server connection please see here: SQL Configuration

Option Default Description
Use SQL Server
to load & save
connections

Off Enable to fetch connections from a database.

1.13.7 Updates

Options for how mRemoteNG should check for updates from the website.

Option Default Description
Check for up-
dates at startup

On (Every 14 days) Here you can choose how often mRemoteNG
checks for updates. Standard is every 14 days

Release Channel Stable The main channel to use for mRemoteNG.
Note that the channels are described under the
selection. Stable is suggested for normal us-
age but its always good to get feedback on
upcoming releases

Use a proxy
server to connect

Off Proxy to connect through to check for up-
dates. This is not a proxy connection for
when you connect to a server but more to
check for updates

1.13.8 Theme

This is not enabled by default but can be used inside mRemoteNG. To enable themes you have to first enable it in the
checkbox at the bottom of the options. Then restart mRemoteNG in order for it to work.
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Note: Default theme is: vs2015light

Note: To know more about themes and how to create your own See Here

1.13.9 Advanced

Option Default Description
Automatically
get session
information

Off

Automatically
try to reconnect
when discon-
nected from
server (RDP &
ICA only)

Off

Use UTF8 en-
coding for RDP
“Load Balance
info” property

Off

Use custom
PuTTY path

Off

To configure
PuTTY sessions
click this button

Launch PuTTY Will launch the putty agent so you can edit
the sessions

Maximum
PuTTY and in-
tegrated external
tools wait time

2 seconds
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Folders and Inheritance

Folders on mRemoteNG cannot only be used to categorize connections but also to inherit properties to underlying
connections.

2.1 Example

You have ten Remote Desktop enabled servers in one domain and 15 in another domain. Normally you would spend a
lot of time creating all those connections and setting the individual properties like username, password, etc.

In mRemoteNG there is an easier way. You just create two folders (one for domain A and one for domain B) and
set all properties there. Then create the connections itself and let it inherit every property. The only properties left to
set on the connection itself are the connection name and hostname. Everything else will be inherited from the parent
folder.

Here is how you do this: Add the folder. This can be done like this:

• Right click on connections and click on New Folder

• File → New Folder

• Or with keybinding: Ctrl+Shift+N

Then give it a name and fill all the properties you need (like you did with the test connection).

When you have filled in the settings and values you can either just drag the test Connection inside the folder or create
a new one.

Right now nothing has changed and nothing will be inherited. To enable inheritance switch to the inheritance view by
clicking the dedicated button. (Marked with a red arrow below)

The properties that show up now are almost the same as before, but you only select yes or no to enable or disable a
inheritance.

When no is selected the property will not be inherited, yes indicates an inherited property. For this test set Inherit
Everything to Yes. Now if you switch back to the properties view (the button left of the inheritance button) you should
see that not much is left of all those properties.
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Only the Name and Hostname/IP properties are left over, everything else will be inherited from the parent folder. Of
course you can also only let some of the properties be inherited. Just play around with this a bit and you’ll get the
hang of it.
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Protocols

mRemoteNG supports several remote connection protocols. See each page for more detailed information.

3.1 RDP Protocol

Microsoft’s Remote Desktop Protocol is a highly configurable remoting protocol.

3.1.1 RDP Protocol Versions

There are several versions of the RDP protocol supported in mRemoteNG. Each newer protocol adds support for
additional connection properties. By default, RDP connections will attempt to use the highest RDP protocol ver-
sion supported by both mRemoteNG and your machine. You can manually select a protocol version using the RDP
Protocol Version connection property.

Note: The ability to select the RDP protocol version was added in mRemoteNG v1.77.1. The RDP 8 protocol was
used from mRemoteNG v1.74.0 to v1.77.0. RDP 5 was used in v1.73 and earlier.
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RDP 6

Property Description
Use Console Session Connect to the console session of the remote host
Server Authentication When connecting, RDP clients attempt to authenticate the remote server to en-

sure that it is who you expect. This option allows you to select how to handle au-
thentication failures. The possible values are Always connect, even if
authentication fails, Don't connect if authentication
fails, Warn me if authentication fails.

Minute to Idle Allows you to specify the number of minutes an RDP connection can sit idle
before automatically being disconnected. A value of 0 means the connection
will never disconnect due to inactivity.

Load Balance Info Load balancing information can be provided to load balancing routers to route
RDP connection requests.

Use CredSSP Allows you to user Credential Security Support Provider (CredSSP) for authen-
tication if it is available.

Use Gateway Specify whether you would like to use an RD Gateway server. Possible values
are Never, Always, Detect

Gateway Hostname The hostname of the RD Gateway server.
Gateway Credentials Allows you to select the authentication to use when connecting to the RD Gate-

way.
• Use the same username and password uses the same au-

thentication information that was specified in the Username, Domain,
and Password fields of the same connection.

• Use a different username and password allows you
to specify alternate credentials using the Gateway Username,
Gateway Password, and Gateway Domain fields.

• Use a smart card uses your current smart card for authenticaton to
the RD Gateway.

Gateway Username The username to use when authenticating to the RD Gateway.
Gateway Password The password to use when authenticating to the RD Gateway.
Gateway Domain The domain to use when authenticating to the RD Gateway.
Resolution Allows you to select the resolution to use when connecting.

• Fit to panel will dynamically select a resolution based on the size
of the connection window. When the connection window is resized, scroll
bars or grey space will be shown. The Automatic Resize connec-
tion property can be used to automatically resize the connection when the
window size changes.

• Fullscreen will place the RDP connection into fullscreen mode im-
mediately after connecting. When the connection window is resized,
scroll bars or grey space will be shown. The Automatic Resize
connection property can be used to automatically resize the connection
when the window size changes.

• Smart size will select an appropriate resolution when initially con-
necting. When the connection window is resized, the connection image
will be stretched or squished to prevent scroll bars or grey space from
being shown.

• Specific resolutions are also provided which will guarantee the resolution
of the connection. Scroll bars or grey space will be shown if the connec-
tion size does not match the connection window size.

Colors Allows you the specify the color quality to use for the connection. Higher values
look better but increases network utilization.

Cache Bitmaps Uses additional system memory to reduce network bandwidth usage.
Display Wallpaper Specifies whether the wallpaper of the remote machine should be shown.
Display Themes Specifies whether the theme of the remote machine should be shown.
Font Smoothing Enabling this option turns on ClearType, making text clearer and easier to read.

Enabling this option increases bandwidth usage of the connection.
Desktop Composition Enables visual effects on the remote desktop and features like glass window

frames, 3D window transition animations, and Windows Flip. Uses more net-
work bandwidth.

Redirect Key Combinations Select whether key combinations (e.g. Alt-Tab) should be redirected to the
remote host.

Redirect Disk Drives Select whether local disk drives should be shown on the remote host.
Redirect Printers Select whether local printers should be shown on the remote host.
Redirect Clipboard Select whether the clipboard should be shared.
Redirect Ports Select whether local ports (ie. com, parallel) should be shown on the remote

host.
Redirect Smart Cards Select whether local smart cards should be available on the remote host.
Redirect Sounds Determine how remote sound should be redirected. Possible values are Bring

to this computer, Leave at remote computer, Do not play
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RDP 7

In RDP 7, support was added for specifying the network connection type. This property is used to determine whether
certain performance options will be honored by the remote server. Some performance settings (such as Display
Wallpaper or Display Themes) will not work when using protocols older than RDP 7 to connect to remote hosts
that are Windows 8 or higher.

Property Description
Sound Quality Specify the quality of sound redirection. Only valid when Redirect

Sounds is enabled. Possible options are Dynamic, Medium, High
Redirect Audio Capture Enabled you to redirect the default audio input device on the remote machine to

your local computer.

RDP 8

In RDP 8, support was improved for reconnecting RDP connections for resizing operations.

Property Description
Automatic Resize When this property is enabled and the connection window is resized, the RDP

connection will automatically reconnect with the new window resolution. This
prevent scroll bars from being shown and preserves the aspect ratio of the
connection (prevents image stretching). This property is only available when
Resolution is set to either Fullscreen or Fit to Panel.

RDP 9

In RDP 9, support was further improved for reconnecting RDP connections for resizing operations.

Property Description
Automatic Resize When this property is enabled and Resolution is set to Fit to Panel

and the connection window is resized, the RDP connection will automatically
change the resolution without reconnecting.

RDP 10

We support this protocol version, but are not yet using any of its features.
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CHAPTER 4

Keyboard Shortcuts

4.1 General

Keybinding Action
F1 Help

4.2 File

Keybinding Action
Ctrl+N New Connection
Ctrl+Shift+N New Folder
Ctrl+O Open Connection File. . .
Ctrl+S Save Connection FIle
Ctrl+Shift+S Save Connection File As. . .

4.3 View

Keybinding Action
Ctrl+Alt+C Jump to (Connections and Config)
Ctrl+Alt+E Jump to (Notifications)
F11 Fullscreen
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4.4 Connections

Keybinding Action
Ctrl+Shift+C Connect
Ctrl+D Duplicate
F2 Rename
Del Delete
Ctrl+Up Move Up
Ctrl+Down Move Down
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CHAPTER 5

SQL Configuration

Warning: The SQL feature is in an early beta stage and not intended for use in a production environment! I
recommend you to do a full backup of your connections and settings before switching to SQL Server.

5.1 Supported Databases

The list below includes databases that are officially supported. Others may already work and this list may expand with
future updates.

• MSSQL

• MySQL

5.2 Steps to configure your SQL Server

• Create a new Database called “mRemoteNG” on your SQL Server.

• Give the users that you want to grant access to the mRemoteNG Connections Database Read/Write permissions
on the Database.

5.3 Steps to configure mRemoteNG for SQL

• Start mRemoteNG if it’s not already running.

• Go to Tools - Options - SQL Server

• Check the box that says “Use SQL Server to load & save connections”.

• Fill in your SQL Server hostname or ip address.
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• If you do not use your Windows logon info to authenticate against the SQL Server fill in the correct Username
and Password.

• Click OK to apply the changes. The main window title should now change to “mRemoteNG | SQL Server”.

• Now click on File - Save to update the tables on your SQL Server with the data from the loaded connections
xml file. (Do not click File - New, this doesn’t work yet)

• You should now be able to do everything you were able to do with the XML storage plus see the changes live
on another mRemoteNG instance that is connected to the same Database.
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CHAPTER 6

Command-Line Switches

The following commandlline switches are supported by mRemoteNG:

/cons: PathToConnectionsFile /c: PathToConnectionsFile

Loads the connections file from the given path. This path can be a: - full file path - path relative to the cur-
rent directory - path relative to the mRemoteNG application directory - path relative to the mRemoteNG
default connection file directory

/reset

Resets window position, panels and toolbars

/resetpos /rp

Reset the windows position

/resetpanels /rpnl

Resets all panel positions. Use this if you have troubles with panel layouts

/resettoolbar /rtbr

Resets the positions of all toolbars

/noreconnect /norc

Temporary disables reconnect to previously opened sessions. Use this if you have problems opening
mRemoteNG after you enabled the setting and restarted mRemoteNG
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CHAPTER 7

Themes

These can be chosen from the File → Options. There are also possibilities to create your own themes inside the settings
for themes. By default mRemoteNG has turned off the themes but they are easily enabled by choosing another theme
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rather then the default (vs2015light) one.

7.1 darculaNG
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7.2 vs2012Blue

7.3 vs2012Dark

7.4 vs2012Light

7.5 vs2013Blue

7.6 vs2013Dark

7.7 vs2013Light

7.8 vs2015Blue

7.9 vs2015blueNG

7.10 vs2015Dark

7.11 vs2015darkNG

7.12 vs2015Light

7.13 vs2015lightNG

Warning: In order for the theme to load, mRemoteNG needs to be restarted
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Troubleshooting

8.1 Logfile

The mRemoteNG.log is located in the following location:

8.1.1 MSI/Installed version

%APPDATA%\mRemoteNG\mRemoteNG.log
(example: `C:\Users\[username]\AppData\Roaming\mRemoteNG\mRemoteNG.log`)

8.1.2 Portable version

[location of mRemoteNG.exe]\mRemoteNG.log

8.2 Crash at Startup

Try deleting the user.config file. It contains all the user-specific program settings. This file is automatically
upgraded between version when new user settings are added.

8.2.1 Installed Version

%LOCALAPPDATA%\mRemoteNG\<most recently updated folder>\<mRemoteNG version>\user.
→˓config

55



mRemoteNG

8.2.2 Portable Version

%APPDATA%\mRemoteNG\<most recently updated folder>\<mRemoteNG version>\user.config

8.3 Crash Information

• Provide the Stack Trace from the crash prompt or from the Windows Application Event Log example)

• Check C:UsersAll UsersMicrosoftWindowsWERReport* folders for any reports related to mRemoteNG

• Check %LOCALAPPDATA%CrashDumps for any mRemoteNG.exe.*.dmp files

• Attach the Error Reports, Dumps and mRemoteNG.log to a new Issue

8.4 Backup and Recovery

By default, your connections file is backed up every time it is saved. These backup files are normal/valid connections
file - they have only been renamed to avoid being overwritten. mRemoteNG will save the 10 most recent backups.

8.4.1 Files and Locations

Your backup files are located in the same place as your normal connections file. This could be one of three places:

• Normal version: %AppData%\mRemoteNG

• Portable version: In the same location as mRemoteNG.exe

• If you have saved your confCons.xml to a custom location, go there.

There are 2 different backup naming schemes:

• confCons.xml.backup is the most recent backup that was taken.

• confCons.xml.YYYYMMDD-HHmmssxxxx.backup is a rolling backup that was moved to a rolling backup file on
the date specified in the file name.

8.4.2 Recovering corrupted connections file

If you find that your confCons.xml file has corrupted or has lost its data, you will need to revert to a previous version.

• Locate your confCons.xml file

• Find the most recent backup file that appears to have data (>1KB in size).

• Rename or delete the corrupted confCons.xml file.

• Rename the chosen backup file to remove the date stamp and .backup suffix. Unless you set a custom path, your
backup file should now be named confCons.xml.
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Known Issues

9.1 mRemoteNG bundles a legacy PuTTY version (below 1.77.2)

mRemoteNG bundles puttyNG, a customized fork to improve the interoperability between Putty and mRemoteNG.
As this bundling process happens with the building process, puttyNG can not be updated in the installer.

Note: Due to the current development progress at the moment there is no stable release bundling the latest puttyNG
version.

PuttyNG can be updated manually with the following steps:

1. Retrieve the newest PuttyNG version from github.com/mRemoteNG/PuTTYNG/releases

2. Replace the local PuTTYNG.exe in the mRemoteNG installation directory

9.2 Problems connecting to servers using SSH with mRemoteNG ver-
sion below 1.77.2

mRemoteNG bundles puttyNG, a customized fork to improve the interoperability between Putty and mRemoteNG.
Older Putty versions might cause connection issues, especially for Ubuntu 22 or other servers that expect PubkeyAc-
ceptedAlgorithms. To fix this issue, either a mRemoteNG update to 1.77.2 or newer is required or the PuTTYNG.exe
has to be replaced manually as follows:

1. Retrieve the newest PuttyNG version from github.com/mRemoteNG/PuTTYNG/releases

2. Replace the local PuTTYNG.exe in the mRemoteNG installation directory
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9.3 CredSSP - CVE-2018-0886 - Authentication error

mRemoteNG uses the Microsoft Terminal Services Client (MSTSC) libraries in order to make Remote Desktop con-
nections.

Note: mRemoteNG has no control over the functionality changes implemented by Microsoft.

Please refer to Microsoft’s Documentation for full details regarding this problem. Patched clients attempting to connect
to Unpatched servers will fail with the following error:

The same error will occur with MSTSC directly on a patched client attempting to connect to an unpatched server.

Per the MS documentation, the only way around this is to do the following:

• Patch the servers (recommended)

• set the “Encryption Oracle Remediation” policy to “Vulnerable” - refer to the MS documentation above for
details (not recommended):

• Uninstall KB4103727 (not recommended)

9.4 Log4net vulnerability CVE-2018-1285 (mRemoteNG version be-
low 1.77.2)

Log4Net is an external library on which mRepoteNG application relies on. While the nightly builds are using the latest
version of log4net that do not have the CVE-2018-1285 vulnerability, older releases require manual patching.

1. Download latest version of log4net from apache.org - currently is v2.0.15

2. Copy log4net.dll from net40 folder into mRemoteNG install folder (default C:\Program Files
(x86)\mRemoteNG\ )

3. Edit mRemoteNG.exe.config and add the following section under the assembly binding for WeifenLuo.
WinFormsUI.Docking
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<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
<dependentAssembly>

<assemblyIdentity name="log4net" publicKeyToken="669e0ddf0bb1aa2a" culture=
→˓"neutral"/>

<bindingRedirect oldVersion="2.0.8.0-2.0.15.0" newVersion="2.0.15.0"/>
</dependentAssembly>

</assemblyBinding>

Make sure the newer log4net version in the bindingRedirect section of mRemoteNG.exe.config file
matches the version of the log4net.dll copied over at step #2. Please refer to Microsoft documentation for
more details related to assembly binding in .NET applications.

9.5 I can’t open more than X number of RDP sessions. New sessions
fail with error code 3334

The issue here is likely the amount of resources available to the RDP component to open the connection. This was
alleviated in MR-714 and MR-864

Other things you can do to help reduce the issue:

• On your RDP connections, set CacheBitmaps to False (this reduces the memory usage of each connection)

• Consider removing KB2830477 if you have it installed. This seems to increase the likelyhood of getting 3334
error codes.

9.6 RDP connections fail with error code 264

This issue is often caused by trying to retrieve session information.

Try doing the following:

• Disable “Automatically get session information” (Tools -> Options -> Advanced)

9.7 ATI Tray Tools

mRemoteNG is not compatible with ATI Tray Tools. We are aware of the issue and hope to have it fixed in a future
version. We recommend that you disable or uninstall ATI Tray Tools while using mRemoteNG.

9.8 mRemoteNG crashes with the error “Class not registered” when
trying to connect using RDP

You may also see a message like “System.Runtime.InteropServices.COMException (0x80040154)”

If you are running mRemoteNG on Windows 7 or Server 2008:

• You may be missing one or more required windows updates.

• A common issue is that KB2574819 is either missing or has been installed after KB2592687. They must be
installed in the correct order. If you do not have KB2574819, follow these instructions: - Uninstall KB2592687
- Install KB2574819 - (Re)Install KB2592687 - Reboot your machine
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If you are running mRemoteNG on Windows 8/10 or Server 2012+:

• Try to repair the mRemoteNG installation using the installer or uninstall/reinstall. Receiving this error on these
OS’s is just an install fluke (or you’ve fiddled with your registry).

9.9 VNC connections fail with the error “The server is using an un-
supported version of the RFB protocol. The server is using ver-
sion 4.1 but only version 3.x is supported.”

RFB version 4.0 and higher is a proprietary version owned by RealVNC Limited. Building support for newer versions
will likely result in licensing fees. Therefore, it is unlikely that mRemoteNG will have support for version 4.0+
anytime soon.

Unfortunately, the only way around this limitation is to use an open source implementation of VNC server such as
TightVNC or UltraVNC

9.10 Cannot click some UI elements in an RDP connection window.

It may seem like some elements are not clickable along the top and left sides of your RDP connection window. More
information can be found in issue #210

This is likely due to non-standard (>100%) DPI scaling on your local machine.

To turn this off:

On Windows 7 / 8

• Start menu -> Control Panel -> Display

• Ensure the option Smaller - 100% (default) is selected

On Windows 10

• Start menu -> Settings -> Display

• Ensure the slider under Change the size of text, apps, and other items is all the way to the left (at 100%)

9.11 SSH login fails when password contains extended ASCII char-
acters

Initial login to SSH (or WinSCP) fails when the password contains extended ASCII characters (such as: Cšœ£ÁØë).
Typing the password into the SSH session directly works.

Investigation suggests that there is an issue in character encoding when mRemoteNG passes the value to the cmd line,
which then invokes PuTTY. This was investigated in issue #186

The only resolution for this issue is to not use extended ASCII characters in passwords that will be sent to PuTTY or
similar tools.

9.9. VNC connections fail with the error “The server is using an unsupported version of the RFB
protocol. The server is using version 4.1 but only version 3.x is supported.”
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9.12 RDP tries to reconnect whenever I resize the window

Your RDP connection reconnects after resizing mRemoteNG or the connection panel.

This will occur anytime the connection window changes size and the following connection options are set:

• Resolution: Fit to Panel

• Automatic Resize: Yes

To prevent reconnecting, you can do one of several things:

• Change RDP Version to Rdc9 or higher. Rdc9 supports resolution changes without reconnecting.

• Change the resolution to Smart Size. This will scale the original connection area when the view window size
changes. This does not preserve aspect ratio.

• Turn off Automatic Resize. When the view window size changes, you will see scroll bars or dead space.

There is no way to update the view window size without a reconnect in RDP Version lower than Rdc9. This is an RDP
protocol limitation.

9.13 AltGr key combinations stop working in other apps when con-
nected to RDP

When connected to an RDP session AltGr, keyboard combinations sometimes stop working.

This is a known issue with The Microsoft RDP library that cannot be solved by mRemoteNG. There are three known
work arounds for this issue:

• Disconnect the RDP session which caused the issue. Since it can be difficult to determine which connection
is to blame, you may need to disconnect all RDP sessions. Once you have confirmed AltGr combinations are
working again, you may reconnect your RDP session(s).

• When the issue occurs, hold/press the Ctrl key. This is known to release the AltGr key from the RDP session.

• Use Ctrl + Alt instead of AltGr.
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CHAPTER 10

Frequently Asked Questions

10.1 PuTTY sometimes displays icons in the terminal

You sometimes see PuTTY icons on the side of the terminal (example below).

This is a new security feature in PuTTY 0.71. It is meant to signify that PuTTY itself is outputting those lines and not
some remote server. Full details are available here.

10.2 How can I edit or create connections in bulk?

Currently, mRemoteNG does not have a feature to support editing or creating connections in bulk. See Creating Bulk
Connections for more info on this.
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CHAPTER 11

SSH Tunneling

You can use any configured SSH connection to be used as a tunnel server for another connection.

If an SSH Tunnel is configured the connection is searched and if found a free local TCP port determined. The SSH
tunnel connection is setup with additional parameters for the tunnel. The original connection info is copied and the
copy is modified to connect to local host and the local TCP port and the target connection is opened. You can use the
SSH connection attribute for additional SSH options. It can be used by all normal SSH connections as well to specify
any additional options, e.g. to not start a shell which some SSH servers.
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CHAPTER 12

External Tools

12.1 Start External Application

This example will create a entry that will launch and login to server using filezilla and sftp. Start with opening up
external tools from: Tools → External Tools And create a New entry. Change Display Name to FileZilla and Filename
to C:\Program Files\FileZilla FTP Client\filezilla.exe. See image below:

We then need to arguments to use for filezilla, which we can find out either by searching for it on the great wide
internet or by called the -h parameter to filezilla.exe in powershell:

& 'C:\Program Files\FileZilla FTP Client\filezilla.exe' -h
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This will open a small dialog showing the various input parameters. What we are going to use is the following for our
entry:

• Application: FileZilla

• Protocol - sftp://

• Input Parameters (variables) - %HOSTNAME%, %USERNAME%,%PASSWORD% and %PORT%

All of the variables are parsed from mRemoteNG connection item to the filezilla command line. So lets build this
entry up in External Tools where we add all these items.

Try the launch the FileZilla based external tool now against the server you want to login too and you will notice that
the application is launched with the variables.

12.2 Traceroute

This example will create a traceroute which you can call on for a connection to get the traceroute to the connection.
Start with opening up external tools from: Tools → External Tools And create a New entry. See External Tools Change
Display Name to Traceroute and Filename to cmd.

See image below:

Now comes the interesting part where we fill in arguments that tells the console what to launch. Here are the parts we
need:

• Keep the console open - /K

• Program to run - tracert

• Variable to use - %HOSTNAME%

So lets fill these options in to the arguments like so:

This is all we really need in order to do a traceroute. Right click on a connection in the connection list and go
to External Tools → Traceroute which will open a cmd prompt and run a tracert against the host using hostname
variable.
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Fig. 1: Figure 1.0: Showing traceroute init settings
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A console like below will appear that show the traceroute and will not exit until you close the window.

If you want to use powershell instead. Then follow information below:

• Filename - powershell.exe

• Arguments - -NoExit tracert %HOSTNAME%

Notice that we replaced the /K with -NoExit and changed cmd with powershell.exe. See image below:

12.3 More examples

Please check Common External Tool Configurations
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CHAPTER 13

Creating Bulk Connections

Currently, mRemoteNG does not have a feature to support editing or creating connections in bulk. Since this is a
common issue, it would be useful to have a work around while a more user-friendly feature is developed. The best
way to create bulk connections is to generate XML with a PowerShell script.

Since you likely don’t want to spend your own time reading through XML files, we have provided an official script for
doing this. You can find the most recent version here.

A few notes about using this script:

• While much of the setup has been done for you, you will still need to know some PowerShell in order to use this
effectively. Some examples have been provided, but you will need to modify the bottom portion of the script to
suite your needs.

• The script works with mRemoteNG v1.75 and will produce XML formatted for use with confCons v2.6 files.
This script may need to be updated for future versions of mRemoteNG.

• As always, feel free to reach out to us in a GitHub Issue or on Gitter if you have issues.
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CHAPTER 14

Connect to virtual machine on Hyper-V

14.1 Introduction

When set up properly, you can use mRemoteNG to connect to virtual machines running on Hyper-V. This how to
provides you with all the information you need to get things running.

To be able to connect to the virtual machine we need its’ id. You can find it by executing the following powershell
command on the Hyper-V server:

Create a new connection, set the protocol to RDP and set the “Use VM ID” property to true. Enter the id in the new
property field that just appeared in the connection section and set the port to 2179.

Enter the id of the virtual machine you found out earlier and you are able to connect to the virtual machine.

14.2 Prerequisites

For the scenario above to work there is some configuration that may be necessary for you to set up, depending on your
environment.

You must be a member of the Administrators and Hyper-V Administrators groups on the Hyper-V Server to be able
to remotely connect to any virtual machine running on the host via VMRDP. If this is not the case your user has to be
granted access to remotely access the machine. The following Powershell command achieves this:

Port 2179 must be open on Hyper-V server and on the machine you are connecting from. Use the following command
to open the ports on the firewall if needed:

In case you are facing “Unknown disconnection reason 3848” error when connecting, you need to configure a number
of registry settings on your client and the Hyper-V Server to make the connection work. This problem occurs because
of the CredSSP (Credential Security Service Provider) policy on the client and/or Hyper-V Server not allowing to
authentication of remote users by default.

Note: See Microsoft support file 954357 for more information on this topic.
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Note: For more information on RDP error codes see this Microsoft article.

Start the PowerShell console with administrative privileges and run the following commands:
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CHAPTER 15

Credential Vault Connector

This feature is currently only developed for Thycotic Secret Server (on-premise installations). It is implemented for
RDP and SSH connections.

mRemote supports fetching credentials from external credential vaults. This allows providing credentials to the con-
nection without storing these to disk, which has numerous benefits (security, auditing, rotating passwords, etc).

Instead of specifying username/password/domain directly in mRemote, leave these fields empty and just set the secret
id:

The secret id is the unique identifier of your secret, you can find it in the URL in your thycotic interface. e.g. https:
//cred.domain.local/SecretServer/app/#/secret/3318/general -> the secret id is 3318

Before initiating the connection mRemote will access your Secret Server API URL and fetch the data. For this to work
the API endpoint URL and access credentials need to be specified. A popup will show up if this information has not
yet been set.
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CHAPTER 16

Dynamic Host Addresses

This feature is in beta and currently supports Amazon EC2 only

Some hosts may have dynamic ip addresses or hostnames. For example, Amazon EC2 instances without elastic ips
change their public address upon stop and restart events. mRemote can automatically update the host property when
ec2 region and instance-id properties are set:

Before initiating the connection, mRemote will contact the EC2 API, fetch the current public ipv4 address and write
it to the host field. Afterwards the connection is initiated as usual.

For this to work, a valid EC2 access key needs to be specified. mRemote will ask for it via a popup window if not yet
specified. This token is then stored to registry. We strongly recommend to generate readonly access keys in the EC2
AMI interface.
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CHAPTER 17

Connecting to CyberArk - Privileged Access Manager

CyberArk’s Privileged Access Manager is a full life-cycle solution for managing the most privileged accounts and
SSH Keys in the enterprise. It enables organizations to secure, provision, manage, control and monitor all activities
associated with all types of privileged identities.

If yours company use it, you may easy setup mRemoteNG to connect through Privileged Session Manager to your
target system.

You should provide in host field yours CyberArk Digital Vault server FQDN or IP address, and in alternate shell field
(under Miscellaneous section):

psm /u target-user /a target-address /c connection-component

/c connection-component should be /c PSM-RDP in this case

Please check CyberArk **documentation** for more detail information about parameters
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CHAPTER 18

Common External Tool Configurations

The list below of various examples is by no means a full list of ways to use External Tools but gives you a idea of
how it can be used in different ways.

18.1 Ping

Ping a server via cmdline.

• Filename: %COMSPEC%

• Arguments: /c ping -t %HostName%

• Can integrate: Unknown

18.2 Traceroute

Run a traceroute via cmdline.

• Filename: %COMSPEC%

• Arguments: /c set /P = | tracert %HostName%

• Can integrate: Unknown

18.3 WinSCP

WinSCP is a free GUI Secure Copy program.

• Filename: C:\Program Files\WinSCP\WinSCP.exe (example path)

• Arguments: scp://%Username%:%Password%@%Hostname%/
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• Optional Arguments - turn on compression and ignore any host key errors: -rawsetting Compression=1 -
hostkey=*

• Can integrate: No

18.4 FileZilla S/FTP

Free and open source FTP client for most platforms.

• Filename: C:\Program Files\FileZilla FTP Client\filezilla.exe (example path)

• Arguments (FTP): ftp://%Username%:%Password%@%Hostname%

• Arguments (SFTP): sftp://%Username%:%Password%@%Hostname%

• Can integrate: Unknown

18.5 Firefox

Don’t like the built-in browser support? Integrate with the Mozilla Firefox browser directly!

• Filename: C:\Program Files\Mozilla Firefox\firefox.exe (example path)

• Arguments: %Hostname%

• Can integrate: Unknown

18.6 Google Chrome

Google Chrome is a freeware web browser developed by Google.

• Filename: C:\Program Files (x86)\Google\Chrome\Application\chrome.exe (example path)

• Arguments: %Hostname%

• Can integrate: Unknown

18.7 Internet Explorer

Standard browser included with Windows installation.

• Filename: C:\Program Files\Internet Explorer\iexplore.exe

• Arguments: %Hostname%

• Can integrate: Unknown

18.8 MySql Workbench

MySQL Workbench provides data modeling, SQL development, and comprehensive administration tools for server
configuration, user administration, backup, and much more. You will be prompted for a password when starting the
connection.
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• Filename: C:\Program Files\MySQL\MySQL Workbench 6.3 CE\MySQLWorkbench.exe (example path)

• Arguments: -query %USERNAME%@%HOSTNAME%

• Can integrate: Unknown

18.9 VNC Viewer

• Filename: C:\Program Files\RealVNC\VNC Viewer\vncviewer.exe (example path)

• Arguments: %HostName%

• Can integrate: Unknown

18.10 Windows Computer Manager

• Filename: %WINDIR%\system32\compmgmt.msc

• Arguments: /Computer=%HostName%

• Can integrate: Unknown

18.11 Zenmap GUI

Zenmap is a GUI front-end for nmap.

• Filename: C:\Program Files\Nmap\zenmap.exe (example path)

• Arguments: -p “Quick scan plus” -t %Hostname%

• Can integrate: Unknown

18.12 UltraVNC

UltraVNC is a free and open source program for connection to remote machines using the VNC protocol.

• Filename: C:\Program Files\UltraVNC\vncviewer.exe (example path)

• Arguments: %HostName%:%port% -password %PASSWORD%

• Can integrate: Unknown

18.13 COM Serial Port

This will allow you to connect to a specific COM serial port using PuTTY.

• Filename: putty.exe (example path)

• Arguments: -serial com%Port%

• Can integrate: Yes

Create a new connection entry with the following information:
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• Name: Serial COM**X**

• Protocol: Ext. App

• External Tool: COM Serial Port

• Port: your desired COM port # here

18.14 Windows PowerShell

Windows PowerShell is a task-based command-line shell and scripting language designed especially for system ad-
ministration.

Running with suggested argument will open a PS session connected to a host. No prompt for credintials will popup.

• Filename: %WINDIR%system32WindowsPowerShellv1.0PowerShell.exe

• Arguments: -noexit $pw = “%password%” -replace ‘^’, ‘’; $password = ConvertTo-SecureString $pw
-AsPlainText -Force; $Cred= New-Object System.Management.Automation.PSCredential (“%username%”,
$password); Enter-PSSession -ComputerName %hostname% -credential $Cred

• Can integrate: No

18.15 Windows PowerShell (ISE)

Windows PowerShell Integrated Scripting Environment (ISE) is a graphical host application that enables you to read,
write, run, debug, and test scripts and modules in a graphic-assisted environment.

• Filename: %WINDIR%\system32\WindowsPowerShell\v1.0\PowerShell_ISE.exe

• Arguments: args here

• Can integrate: Yes

18.16 To get all windows file systems attributes of the remote server

It’s could be very useful for database and application servers to know all windows file systems attributes of the remote
server, the size in mb, free space in mb and free % including all lettered drives ( e.g c: ) as well as mounted drives.
Mounted drives are tricky to find and interrogate by other means.

You must run mR as a user with appropriate permission on the remote server: shortcut =
C:WindowsSystem32runas.exe /user:domainntuser “C:Program FilesmRemoteNGmRemoteNG.exe”

• Filename: %SystemRoot%system32WindowsPowerShellv1.0powershell.exe

• Arguments: -NoExit Get-WmiObject Win32_Volume -ComputerName %hostname% | Format-Table
Name, @{Name=”Size(MB)”;Expression={“{0:0,0.00}” -f($_.Capacity/1mb)}}, @{Name=”Free
Space(MB)”;Expression={“{0:0,0.00}” -f($_.FreeSpace/1mb)}}, @{Name=”Free (%)”;Expres-
sion={“{0,6:P0}” -f(($_.FreeSpace/1mb) / ($_.Capacity/1mb))}}

• Can integrate: No

Result will be similar to this:

You do not need to be logged into the remote server – just highlight the name.

(suggested by: Ray Miller)
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CHAPTER 19

Migrate Settings from mRemote

mRemoteNG does not automatically migrate settings from old (non-NG) versions of mRemote. You will manually
need to copy your settings files from mRemote to mRemoteNG.

19.1 On Windows XP / Windows Home Server / Windows Server 2003

Copy all the files in this folder:

C:\Documents and Settings\[username]\Local Settings\Application Data\Felix_
→˓Deimel\mRemote

To this folder:

C:\Documents and Settings\[username]\Local Settings\Application Data\mRemoteNG

19.2 On Windows Vista / Windows 7 / Windows Server 2008

Copy all the files in this folder:

C:\Users\[username]\AppData\Local\Felix_Deimel\mRemote

To this folder:

C:\Users\[username]\AppData\Local\mRemoteNG

If you keep both programs installed on your computer, changes within one program will not affect the other.
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CHAPTER 20

Mail

If you want to contact the mRemoteNG project maintainers use the following address: support@mremoteng.org

If you have found a security vulnerability, that you feel shouldn’t be made public, please report this to the following
address: security@mremoteng.org We will work together to determine public disclosure. If you do not recieve a
response within 48 hours to the e-mail file an issue on GitHub and tag @sparerd and @kmscode within the issue.
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